


















Сохранение и загрузка информации

Сохранение и загрузка информации

В настоящем разделе описываются действия по сохранению и загрузке экранных изображений и настроек,
сохранения результатов измерений, использования буфера обмена и печати при помощи прибора. Подробные
сведения по этой теме содержатся в интерактивной справке.

Сохранение изображений с экрана

1. Выберите последовательно File >
Save или Save As > Screen Capture...

2. Чтобы настроить формат групп
параметров Palette (палитра), View
(вид), Image (изображение) или Screen
Capture Format (формат изображения
с экрана), щелкните Options...
(параметры...) или перейдите к
шагу 3.
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3. Выберите местоположение для
сохранения изображения с экрана.

4. Введите имя изображения с экрана
или используйте имя, данное по
умолчанию, и выберите тип файла.

5. Нажмите кнопку Save.

Совет

Для быстрого сохранения нескольких изображений с экрана выберите Set Front Panel Print Button to Save и
нажмите кнопку Save. Теперь можно экспортировать данные нажатием кнопки Print на передней панели.

Сохранение осциллограмм

1. Для сохранения осциллограмм
выберите File > Save или Save As >
Waveform...
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2. Щелкните Waveform.

3. Если вы хотите определить Waveform
Data Range (диапазон данных
осциллограммы), Fast Frame Data
Range (диапазон данных быстрой
записи кадров), Waveform Detail
(форма сигнала), Data Destination
(назначение данных), Source
(источник) или Data Ordering (порядок
данных), щелкните Options...
(параметры...), в противном случае
перейдите к шагу 4.

4. Выберите источник.

5. Можно сохранить осциллограмму
как опорную в памяти прибора или
как WMF-файл в каталоге Windows.
Чтобы сохранить осциллограмму
как опорную, выберите Ref 1-4. Для
сохранения в качестве WFM-файла
выберите место для сохранения
осциллограммы.

6. При сохранении в качестве
WFM-файла введите имя файла
или используйте имя, заданное по
умолчанию.

7. Нажмите кнопку Save.

Советы

Для того чтобы сохранить похожие осциллограммы, не вводя каждый раз очередное имя, выберите
Auto-increment file name (автонумерация файлов).

Для быстрого сохранения нескольких осциллограмм выберите Set Front Panel Print Button to Save и нажмите
кнопку Save. Теперь можно сохранять осциллограммы нажатием кнопки Print на передней панели.
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Загрузка осциллограмм

1. Выберите File > Recall...

2. Щелкните Waveform.

3. Выберите формат данных для
загружаемой осциллограммы.

4. Выберите загружаемую
осциллограмму.

5. Нажмите кнопку Recall. При выборе
команды Recall активируются опорные
осциллограммы и окно управления
ими.

6. Используйте элементы управления
для регулировки опорной
осциллограммы. Еще один способ
получить доступ к окну управления
опорными осциллограммами -
выбрать File > Reference Waveform
Controls...
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Совет

Можно сохранить файлы в нескольких различных форматах, но загрузить можно только SET- и WFM-файлы.

Сохранение цифровых осциллограмм
В приборах серии MSO имеется возможность сохранять цифровые осциллограммы в файле формата CSV.

1. Для сохранения цифровых
осциллограмм выберите File >
Save (файл > сохранить) или Save As
> Digitals (сохранить как > цифровой
сигнал).

2. Щелкните Digitals (цифровой сигнал).

3. Цифровые осциллограммы можно
сохранять только как файлы формата
CSV в каталоге Windows. При
сохранении файла осциллограммы в
формате CSV выберите место, куда
его желательно поместить.

4. Введите имя файла или используйте
имя, заданное по умолчанию.

5. Нажмите кнопку Save (сохранить).
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Сохранение настроек прибора

1. Выберите File > Save или Save As >
Setup...

2. Щелкните Setup (настройка).

3. Выберите место для сохранения
настроек. Можно сохранить настройки
в памяти прибора в одном из десяти
мест хранения или в качестве
SET-файла в каталоге Windows.

4. Введите имя файла или используйте
имя, заданное по умолчанию.
Чтобы ввести имя файла настроек,
сохраняемых в памяти прибора,
воспользуйтесь виртуальной
клавиатурой.

5. Нажмите кнопку Save.

Советы

Если сенсорный экран включен, то для маркировки файлов параметров настройки с целью упрощения
идентификации используйте виртуальную цифровую клавиатуру.

Чтобы сохранить похожие файлы, не вводя каждый раз полное имя файла, используйте автонумерацию.

Для быстрого сохранения нескольких настроек выберите Set Front Panel Print Button to Save и нажмите кнопку
Save. Теперь можно сохранять настройки нажатием кнопки Print на передней панели.
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Загрузка настроек прибора

1. Выберите File > Recall...

2. Щелкните Setup.

3. Выберите настройки, которые
требуется загрузить. Файл настроек
можно загрузить из одного из десяти
мест хранения в памяти прибора или
из каталога Windows.

Чтобы сохранить текущие
настройки компенсации временного
запаздывания, щелкните Don't
recall deskew values (не вызывать
значения компенсации временного
запаздывания).

4. Нажмите кнопку Recall.

Совет

Для ускорения доступа можно загрузить любые сохраненные на диске настройки, после чего сохранить их,
используя внутреннее место хранения настроек.
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Сохранение результатов измерений

1. Выберите File > Save (файл
> сохранить) или Save As >
Measurement... (сохранить как >
измерение...).

2. Чтобы определить Displayed
Measurements (отображенные
измерения), Measurement Snapshot
(снимок измерения) или Measurement
Format (формат измерения), нажмите
кнопку Options... (параметры...). В
противном случае перейдите к шагу 3.

3. Выберите местоположение для
сохранения результатов измерений.

4. Введите имя результатов измерений
и выберите тип файла.

5. Нажмите кнопку Save.
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Сохранение масок пользователя

1. Выберите File > Save (файл >
сохранить) или Save As > User Mask
(сохранить как > маска пользователя).

2. Щелкните пункт User Mask (маска
пользователя).

3. Выберите местоположение для
сохранения маски.

4. Введите имя маски и выберите тип
файла.

5. Нажмите кнопку Save (сохранить).
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Сохранение данных гистограммы

1. Выберите пункты File > Save (файл >
сохранить) или Save As > Histogram
Data (сохранить как > данные
гистограммы).

2. Выберите пункт Histogram
(гистограмма). В зависимости от
того, каким был предыдущий выбор,
может возникнуть потребность
перейти к пунктам меню More >
Histogram Data (дополнительно
> данные в виде гистограммы)
для отображения данных в виде
гистограммы.

3. Выберите местоположение для
сохранения гистограммы.

4. Введите имя гистограммы и выберите
тип файла.

5. Нажмите кнопку Save (сохранить).
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Сохранение меток времени

1. Выберите пункты File > Save (файл >
сохранить) или Save As > Timestamp
Table (сохранить как > таблица меток
времени).

2. Выберите значок Timestamp (метка
времени). В зависимости от того,
каким был предыдущий выбор, может
возникнуть потребность перейти к
пунктам меню More > Timestamp
Table (дополнительно > таблица
отметок времени) для отображения
выборки отметок времени.

3. Чтобы определить Source (источник)
или FastFrame Data Range
(диапазон данных быстрой записи
кадров), нажмите кнопку Options...
(параметры...). В противном случае
перейдите к шагу 4.

4. Выберите местоположение для
сохранения метки времени.

5. Введите имя метки времени и
выберите тип файла.

6. Нажмите кнопку Save (сохранить).
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Копирование результатов в буфер обмена
Чтобы задать информационное наполнение и формат для копирования изображений, осциллограмм и результатов
измерений в буфер обмена Windows, воспользуйтесь следующей процедурой.

1. Выберите Edit > Copy Setup...

2. Щелкните вкладку Images, Waveforms
или Measurements и выберите
нужные параметры.
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Для копирования изображений, осциллограмм или результатов измерений выполните следующие действия:

1. Выберите элемент для копирования.

2. Выберите Edit > Copy или нажмите
комбинацию клавиш Ctrl + C.

3. Для вставки элемента в приложение
Windows нажмите комбинацию клавиш
Ctrl + V.
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Настройка для печати

1. Чтобы распечатать копию документа,
нажмите на кнопку печати или
выберите пункты меню File > Print
(файл > печать). При необходимости
можно изменить ориентацию
страницы в диалоговом окне Page
Setup (настройка параметров
страницы).

Диалоговые окна печати и настройки
параметров страницы зависят от
применяемого принтера.

2. Нажмите кнопку Page Setup...

3. Выберите параметры печати.
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Запуск приложений

Для каждого приложения допускается сделать на приборе десять пробных запусков. Данные приложения
обеспечивают специфические возможности проведения измерений. Ниже описаны некоторые примеры их
использования. Кроме того могут быть доступны дополнительные пакеты. Некоторые приложения на данном
приборе могут быть недоступны. Для получения дополнительных сведений обратитесь к представителю компании
Tektronix или посетите веб-узел по адресу www.tektronix.com.

Используйте приложение DDRA Memory Bus Analysis для автоматической идентификации считывания и записи
DDR1, LP-DDR1, LP-DDR2, LP-DDR3, DDR2, DDR3, DDR4, DDR3L, GDDR3 и GDDR5.

Используйте приложение DJA DPOJET Jitter and Eye Diagram Analysis, Advanced для надежного измерения
сложных тактовых, цифровых и последовательных сигналов данных. Основные функции DPOJET входят в
стандартную комплектацию всех моделей.

Приложение D-PHY для отладки, определения параметров и проверки на совместимость передатчиков на базе
решения MIPI D-PHY (требует опции DJA).

Используйте приложение DSPT Display Port Compliance Software для обоснования вашего проекта ИС,
материнской платы и видеокарты.

Программное обеспечение DVI Compliance Test Solution Software используется для испытаний на совместимость
с физическим слоем DVI.

Приложение ERRDT Frame and Bit Error Rate Detector, детектор коэффициента кадровых и битовых ошибок,
предназначено для обнаружения ошибок в высокоскоростных последовательных стандартах (требует опции
ST6G).

Приложение ET3 предназначено для проверки соответствия коммуникационным стандартам 10/100/1000 Base-T
ethernet.

Приложение HT3 HDMI Compliance Test Software предназначено для тестирования на соответствие стандарту
интерфейса HDMI моделей с полосой пропускания ≥4 ГГц.

Приложение HT3DS HDMI Direct Synthesis for HDMI 1.4 (требуется HT3) предназначено для анализа сигнала
HDMI.

Используйте приложение LT Waveform Limit Testing для сравнения полученной осциллограммы с установленными
вами пределами допустимых отклонений.

Используйте основные функции MOST для проверки соответствия электротехническим стандартам и отладки
MOST50 и MOST150.

Программное обеспечение MTH Communication Mask Testing Software используется для тестирования с маской
для моделей ≥4 ГГц.

Приложение MTM Communication Mask Testing Software используется для проведения тестирования соответствия
с маской на моделях с полосой пропускания <4 ГГц.

Используйте тест совместимости PCE3 PCI-Express для Gen3. Используется с DPOJET.

Тест на совместимость PCE предназначен для Gen1 и Gen2. Может использоваться с DPOJET или RTE.

Приложение для измерения параметров источника питания PWR Power Measurement Software предназначено
для быстрого измерения и анализа рассеяния энергии в импульсных источниках питания и магнитных элементах.

Приложения SLA и SLE предназначены для эмуляции канала последовательных данных, отключения фиксации,
добавления или удаления коррекции передатчика. SLA добавляет обработку сигналов с коррекцией.
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Приложение SR-810B используется для включения последовательной синхронизации и анализа сигналов 8B10B.

Приложение SR-AERO предназначено для последовательной синхронизации и анализа MIL-STD-1553.

Используйте SR-AUTO для запуска по сигналам последовательных шин, отладки, декодирования и анализа
сигналов шин CAN, LIN и FlexRay.

Приложение SR-COMP предназначено для включения последовательной синхронизации и анализа сигналов,
передаваемых через интерфейсы RS-232/422/485/UART.

Приложение SR-DPHY предназначено для анализа последовательного сигнала MIPI-DSI1 и MIPI-CSI2.

Приложение SR-EMBD используется для включения последовательной синхронизации и анализа сигналов I2C
и SPI.

Приложение SR-ENET предназначено для последовательного анализа сигналов Ethernet.

Приложение SR-PCIE предназначено для анализа совместимости последовательных данных (для
последовательной синхронизации требуется ST6G).

Приложение SR-USB используется для включения запуска по сигналам последовательных шин и анализа
сигналов USB2.0 и USB3.0.

Приложение ST1G или ST6G Serial Protocol Trigger Software предназначено для синхронизации и декодирования
8-разрядных и 10-разрядных данных в высокоскоростных протоколах обмена данными и последовательных
протоколах. Синхронизация протоколов с частотой до 6,25 Гвыб/с.

Приложения SVP, SVM и SVE Spectral Analysis используются для обоснования широкополосных проектных
решений и описания широкополосных спектральных событий.

Приложение SVO предназначено для гибкого анализа OFDM, требует наличия SVE.

Приложение SVT предназначено для организации временных измерений (частота и фаза), требует наличия SVE.

Приложение USB предназначено для определения характеристик сигналов USB 2.0, включая тестирование с
маской и параметрическое тестирование.

Приложение USB3 используется для проверки, описания, отладки и испытания на соответствие систем USB 3.0
(требует опции DJA).

Приложение VET используется для активации визуального запуска и поиска.

Приложение XGBT предназначено для испытания на электрическое соответствие физического уровня (PHY)
подсоединения к физической среде (PMA) сети Ethernet поколения 10GBASE-T.

Для установки приложений следуйте
прилагаемым к ним инструкциям. Чтобы
запустить приложение, выберите Analyze
и затем укажите нужное приложение.
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Примеры применения

В этом разделе описаны примеры применения прибора в типичных случаях устранения неполадок и способы
расширения возможностей прибора.

Регистрация периодически возникающих аномалий
Одной из наиболее сложных операций, к которой сталкиваются инженеры-проектировщики, является отслеживание
причины возникновения периодических аномалий. Если определен тип аномалии, которую нужно обнаружить, можно
с легкостью настроить осциллограф на расширенную синхронизацию для устранения данной аномалии. Если
неизвестно, что нужно обнаружить, процедура может затянуться и потребовать много времени для обнаружения
редко встречающейся аномалии, особенно при низкой скорости регистрации сигналов на обычном цифровом
запоминающем осциллографе.

Цифровой люминисцентный осциллограф с применением технологии DPX имеет высокоскоростной режим
регистрации, называемый FastAcq, который позволяет обнаруживать аномалии, как в случае с секундами или
минутами. Обычный цифровой запоминающий осциллограф для обнаружения такой же аномалии использует
часы или дни.

Воспользуйтесь следующей процедурой для регистрации периодически возникающих аномалий.
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1. Подсоедините пробник к источнику
входного сигнала.

2. Нажмите кнопку Autoset.

Серии MSO/DPO70000DX, MSO/DPO70000C и DPO7000C

Серии MSO5000B и DPO5000B
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3. Выберите Display > Display
Persistence > Infinite Persistence.
В данном примере требуется
обнаружить тактовый сигнал. После
наблюдения за сигналом в течение
1-2 минут, но перед началом поиска
проблемы в другом месте, перейдите
к шагу 4.

4. Нажмите кнопку FastAcq.

Серии MSO/DPO70000DX, MSO/DPO70000C и DPO7000C

Серии MSO5000B и DPO5000B

5. Найдите выбросы, переходные
процессы и другие случайные
аномалии сигнала. В данном
примере с помощью функции
быстрой регистрации FastAcq
обнаруживается положительный
выброс длительностью ≈300 нс по
истечении нескольких секунд.
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6. Чтобы установить запуск
синхронизации по пику выброса,
определенного при выполнении
шага 5, выберите Glitch Setup...
(Настройка выброса).

7. Выбор соответствующую полярность.

8. Щелкните Level (Уровень), а затем
установите уровень, основываясь на
данных, полученных в шаге 5.

9. Щелкните Width (Длительность),
а затем установите длительность,
основываясь на данных, полученных
в шаге 5.

Установите флажок HF Filtering
(фильтрация ВЧ), если требуется
синхронизировать систему так, чтобы
обрабатывать высокочастотную
импульсную вспышку, как один
импульс.

10. Выберите для элемента E-mail on
Trigger (Электронная почта по сигналу
запуска) значение On. (См. стр. 99,
Настройка отправки сообщения о
событии по электронной почте.)

11. Нажмите кнопку Single для запуска по
одному выбросу.

Серии MSO/DPO70000DX, MSO/DPO70000C и DPO7000C

Серии MSO5000B и DPO5000B
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Использование расширенного рабочего стола и архитектуры OpenChoice
для повышения эффективности документирования

Нередко возникает необходимость в документировании работы инженера в лаборатории для дальнейшего
использования. Вместо сохранения снимков экрана и осциллограмм на компакт-диске или запоминающем
устройстве USB для последующего создания отчета можно использовать архитектуру OpenChoice для
документирования работы в реальном времени.

Чтобы превратить прибор в основное средство разработки и документирования, выполните следующие действия.

ПРИМЕЧАНИЕ. Для работы на 64-разрядных системах потребуются совместимые с ними 64-разрядные
драйверы устройств и прикладные программы.

1. Загрузите в прибор приложение
Microsoft Word или Excel.

2. Подсоедините второй монитор.
(См. стр. 12, Добавление второго
монитора.)

3. Откройте Microsoft Word и перетащите
окно Word на расширенный рабочий
стол.

4. Щелкните TekScope, чтобы
восстановить приложение прибора.
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Примеры применения

5. Выберите Edit > Select for Copy > Full
Screen (bitmap).

6. Нажмите клавиши Ctrl+C.

7. Щелкните место документа Word, в котором требуется разместить снимок экрана, и нажмите клавиши Ctrl+V.

Советы

В комплект прибора входит несколько программных средств OpenChoice, предназначенных для обеспечения
максимальной эффективности и возможности подключения к другим средствам разработки.

Синхронизация по шинам
Данный прибор можно использовать для запуска по сигналам шин I2C, SPI, RS-232/422/485/UART, MIPI DSI-1, MIPI
CSI-2, 8B/10B, USB, CAN и параллельной. На экране прибора отображается физический уровень шины (в виде
аналоговых осциллограмм), а также информация на уровне протокола (в виде цифровых осциллограмм и символов).

ПРИМЕЧАНИЕ. Некоторые типы синхронизации на некоторых приборах недоступны.

Подробное описание процедур синхронизации шины приведено в разделах (См. стр. 91, Синхронизация по
параллельной шине.) и (См. стр. 94, Синхронизация по последовательной шине.)

Для настройки синхронизации по шине необходимо выполнить следующие действия.

1. Выберите пункты Vertical > Bus Setup
(по вертикали > настройка шины).
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2. Выберите тип шины.

3. Если вы выбрали тип шины Serial
(последовательная) в разделе Bus
Type (тип шины), выберите тип
последовательной шины.

4. Укажите компоненты.

5. Выберите Trig > Bus Setup
(синхронизация > настройка шины).

6. Выберите шину, которую вы
настроили.

7. Выберите Trigger On (синхронизация
по) для указания необходимого
элемента для синхронизации.

8. В зависимости от выбора
Trigger On (синхронизация по),
возможно, потребуется осуществить
дополнительный выбор.

Синхронизация по видеосигналу
Устройство поддерживает синхронизацию сигналом NTSC, SECAM, PAL и сигналом высокой четкости.

Синхронизация по полям видеосигнала.

ПРИМЕЧАНИЕ. Тип запуска по видеосигналу имеется в наличии только в приборах серий DPO7000C, MSO5000B
и DPO5000B.
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1. Выберите Trig > A Event (Main)
Trigger Setup...

2. Задайте тип и источник синхронизации
А на вкладке события A Event.

Выберите Format > 525/NTSC.

3. Выберите последовательно Trigger
On > Field.

Выберите поле Odd, Even или All.

Синхронизация по строкам

Просмотр строк видеосигнала в пределах поля.
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1. Выберите Trig > A Event (Main)
Trigger Setup...

2. Задайте тип и источник синхронизации
А на вкладке события A Event.

Выберите Format > 525/NTSC.

3. Выберите Trigger On > All Lines.

Сопоставление данных осциллографа и логического анализатора
Tektronix

Как правило, разрабатываются быстродействующие устройства с крутыми фронтами тактовых сигналов и высокими
скоростями передачи данных. Для таких разработок необходимо просматривать аналоговые характеристики
высокочастотных цифровых сигналов с привязкой к сложным событиям в цифровом устройстве. Функция iView
служит окном в цифровой и аналоговый мир одновременно. Возможности iView позволяют легко интегрировать и
автоматически сопоставлять во времени данные, полученные с логических анализаторов и осциллографов Tektronix
и одним щелчком мыши переносить аналоговые осциллограммы с осциллографа на экран логического анализатора.
Совместный просмотр связанных во времени аналоговых и цифровых сигналов позволяет быстро обнаружить
источники трудноуловимых выбросов и других неполадок.

Кабель iView для внешнего осциллографа (iView External Oscilloscope Cable) позволяет подсоединить логический
анализатор к осциллографу Tektronix, устанавливая связь между этими приборами. Мастер добавления внешнего
осциллографа, доступ к которому осуществляется через меню System приложения TLA, выполняет подключение
кабеля iView между логическим анализатором и осциллографом.
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Имеется также окно настройки, обеспечивающее проверку, изменение и тестирование настроек осциллографа.
Прежде чем приступать к записи сигналов и просмотру осциллограмм, необходимо установить подключение между
логическим анализатором и осциллографом Tektronix с помощью мастера Add External Oscilloscope (добавление
внешнего осциллографа).

1. Выберите Add iView External
Oscilloscope... в меню System
логического анализатора.

2. Выберите модель осциллографа.

3. Выполните инструкции на экране, а
затем нажмите кнопку Next.

4. Дополнительные сведения о
сопоставлении данных логического
анализатора и осциллографа
см. в документации логического
анализатора Tektronix.
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Технические характеристики

Технические характеристики

В настоящем разделе перечислены гарантированные технические характеристики приборов серий MSO70000DX,
DPO70000DX, MSO70000C, DPO70000C, DPO7000C, MSO5000B и DPO5000B. Все гарантированные технические
характеристики помечены (при помощи символа ) в руководстве по техническим характеристикам и проверкам
эксплуатационных параметров. Типичные технические характеристики приводятся для удобства, но их значения
могут отличаться от указанных. Если не указано иное, все технические характеристики относятся ко всем приборам.

Сохранение характеристик гарантируется при соблюдении следующих условий.

Осциллограф должен быть откалиброван при температуре от 18 до 28 °C.

Осциллограф должен быть подключен к источнику питания, имеющему указанные характеристики. (См.
таблицу 8 на странице 224.)

Осциллограф должен эксплуатироваться в указанных условиях. (См. таблицу 10 на странице 226.)

Осциллограф должен проработать непрерывно, по крайней мере, в течение двадцати минут в указанном
диапазоне температур.

Процедуру компенсации сигнального тракта следует выполнять после 20-минутного прогрева. Если температура
окружающей среды изменится больше чем на 5 °C, повторите процедуру.

Таблицы технических характеристик
Таблица 1: Характеристики входных каналов и разрешения по вертикали

Характеристика Описание

Входное сопротивление,
связь по постоянному
току, модели DPO7000C

1 МОм:

50 Ом:

1 Мом ±1 % параллельно с 13 пФ ±2 пФ

50 Мом ±1 %, типично

Входное
сопротивление, связь
по постоянному току,
модели MSO5000B и
DPO5000B

1 МОм:

50 МОм:

1 МОм ±1 % параллельно с 13,5 пФ ±2 пФ

50 Ом ±1%

Входное
сопротивление, модели
MSO/DPO7000C

От 100 мВ ФС до 995 мВ ФС:50 Ом ±1,5 % при 25 °C 50 Ом ±2,0 % от 10 до 45 °C,
пройдены типовые испытания

От 1 В ФС до 5 В ФС:50 Ом ± 1,5 % при 25 °C

Входное
сопротивление, модели
MSO/DPO70000DX

Настройки ≤ 1,2 В ПС:50 Ом ±3 % от 18 до 28 °C, 50 Ом ±4 % от 5 до 45 °C>Настройки
≤ 1,2 В ПС:50 Ом ±4,4 % от 5 до 45 °C

Баланс по
постоянному току,
модели MSO5000B и
DPO5000B

0,1 деления со связью по постоянному току на входе и нагрузкой 50 Ом.

0,2 деления со связью по постоянному току на входе и нагрузкой 1 МОм.
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Погрешность
коэффициента усиления
по постоянному току

Модели DPO7000C: с общим смещением =0 В
±1,0 %, дополнительные 0,5 % для диапазонов <2 мВ/дел., дополнительные
1,5 % x |общее смещение/максимальное смещение| для диапазонов <5 мВ/дел.,
дополнительные 0,5 % x |общее смещение/максимальное смещение| для диапазонов
≥ 5 мВ/дел., дополнительные 0,5 % для диапазонов ≥1 В/дел. при связи 1 МОм
и смещении >10 В

Модели MSO/DPO70000DX и MSO/DPO70000C: ±2%

Модели MSO/DPO5204B и MSO/DPO5104B:тракт с сопротивлением 50 Ом: ±1,5 %,
снижение со скоростью 0,100 %/°C выше 30 °C±3,0 %, переменная чувствительность,
снижение со скоростью 0,100 %/°C выше 30 °C1 MОм, тракт TPP0500/B и TPP1000:
±2,0 %, снижение со скоростью 0,100 %/°C выше 30 °C, настройка 1 мВ/дел. ±1,5 %,
снижение со скоростью 0,100 %/°C выше 30 °C±3,0 %, переменная чувствительность,
снижение со скоростью 0,100 %/°C выше 30 °C

Модели MSO/DPO5054B и MSO/DPO5034B:50 Ом, 1 МОм, тракт TPP0500/B и
TPP1000:±2,0 %, снижение со скоростью 0,100 %/°C выше 30 °C, настройка
1 мВ/дел. ±1,5 %, снижение со скоростью 0,100 %/°C выше 30 °C±3,0 %, переменная
чувствительность, снижение со скоростью 0,100 %/°C выше 30 °C
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Тип измерения Погрешность, В

Общее смещение = смещение – (положение х
вольт/деление)

Усреднение ≥16
осциллограмм

±[погрешность коэффициента усиления по постоянному
току × | показание –(общее смещение) | + точность
смещения + 0,1 деления ]

Измерение разности
напряжений между
любыми двумя
усредненными
значениями из
≥16 осциллограмм,
записанных при
одинаковых настройках
и условиях окружающей
среды

±(Усиление по постоянному току × | показание | + 0,05
деление)

Режим выборки,
стандартное значение

±[погрешность коэффициента усиления по постоянному
току × | показание –(общее смещение) | + точность
смещения + 0,15 деления + 0,6 мВ]

±[Усиление по постоянному току × | показание | + 0,15
деления + 1,2 мВ]

Точность измерения
напряжения постоянного
тока

Модели DPO7000C

Линейное напряжение
между любыми двумя
выборками, полученными
при одинаковых
настройках и условиях
окружающей среды,
стандартное значение

Преобразуйте значения смещения, положения и
постоянного смещения в вольты путем умножения на
соответствующее значение В/дел.

Характеристика относится к любой выборке и к
измерениям в режимах High (Выс.), Low (Низк.), Max
(Макс.), Min (Мин.), Mean (Средн.), Cycle Mean (Среднее
значение цикла), RMS (Ср. квадр. значение) и Cycle
RMS (Ср. квадр. значение цикла). Характеристика
линейного напряжения относится к вычислениям
с вычитанием, включая эти два измерения.
Характеристика линейного напряжения относится
к измерениям Positive Overshoot (Положительный
выброс), Negative Overshoot (Отрицательный выброс),
Pk-Pk (Амплитуда пик-пик) и амплитуды.
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Тип измерения Значение
чувствительности

Погрешность, В

От 100 мВ/ФС до 995
мВ/ФС

±[(2 % х | показание
- общее смещение |
+ 0,35 % × | общее
смещение | + 1,5 мВ +
0,014 х ФС]

Режим усреднения (≥ 16
усреднений)

От 1 В/ФС до 5 В/ФС ±[(2 % х | показание
- общее смещение |
+ 0,35 % × | общее
смещение | + 7,5 мВ +
0,014 х ФС]

Точность измерения
напряжения постоянного
тока

Модели
MSO/DPO70000C

Измерение разности
напряжений между
любыми двумя
усредненными
значениями из
≥16 осциллограмм,
записанных при
одинаковых настройках
и условиях окружающей
среды

От 100 мВ/ФС до 5 В/ФС ±[2 % х | показание | +
0,008 дел х ФС]

Тип измерения Значение
чувствительности

Точность по пост. току,
В

Регистрация в режиме
захвата усреднения
Average, не менее
16 усреднений

От 62,5 мВ/ПС до
1,2 В/ПСОт 1,2 до 6 В/ПС

±[2 % × | показание -
общее смещение | + 0,4 %
× | общее смещение | +
0,2 % × | общее смещение
– настройка Vterm | +
2,5 мВ + 0,014 × ПС]±[2 %
× | показание - общее
смещение | + 0,4% ×
| общее смещение | +
12,5 мВ + 0,014 × ПС]

Точность измерения
напряжения постоянного
тока

Модели
MSO/DPO70000DX

Измерение разности
напряжений между
любыми двумя
усредненными
значениями из
≥16 осциллограмм,
записанных при
одинаковых настройках
и условиях окружающей
среды

От 62,5 мВ/ПС до 6 В/ПС ±[2 % × | показание
- общее смещение| +
0,008 дел. × ФС]
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Характеристика Описание

Тип измерения Погрешность, В

Усреднение ≥16
осциллограмм

±[погрешность коэффициента усиления по постоянному
току × | показание –(смещение - положение) | + точность
смещения + 0,1 деление ]

Точность измерения
напряжения постоянного
тока

Модели MSO5000B и
DPO5000B Измерение разности

напряжений между
любыми двумя
усредненными
значениями из
≥16 осциллограмм,
записанных при
одинаковых настройках
и условиях окружающей
среды

±(погрешность коэффициента усиления по постоянному
току × | показание | + 0,05 деление)

Вход 50 Ом со связью по постоянному току, полная полоса пропускания, допуск на
амплитуду -3 дБ, эксплуатация при температуре ≤30 °C.

Модель Масштаб Точность смещения

10 мВ/дел - 1 В/дел От 0 до 3,5 ГГц, BWE вкл

От 0 до 2,5 ГГц, BWE выкл

5 мВ/дел - 9,9 мВ/дел От 0 до 2 ГГц

2 мВ/дел - 4,99 мВ/дел От 0 до 500МГц, типичное
значение

DPO7354C

1 мВ/дел - 1,99 мВ/дел От 0 до 200МГц, типичное
значение

10 мВ/дел - 1 В/дел От 0 до 2,5 ГГц

5 мВ/дел - 9,9 мВ/дел От 0 до 2 ГГц

2 мВ/дел - 4,99 мВ/дел От 0 до 500МГц, типичное
значение

DPO7254C

1 мВ/дел - 1,99 мВ/дел От 0 до 200МГц, типичное
значение

5 мВ/дел - 1 В/дел От 0 до 1 ГГц

2 мВ/дел - 4,99 мВ/дел От 0 до 500МГц, типичное
значение

DPO7104C

1 мВ/дел - 1,99 мВ/дел От 0 до 200МГц, типичное
значение

5 мВ/дел - 1 В/дел От 0 до 500 МГц

2 мВ/дел - 4,99 мВ/дел От 0 до 400МГц, типичное
значение

Полоса пропускания
аналогового сигнала,
связь по постоянному
току, модели DPO7000C

DPO7054C

1 мВ/дел - 1,99 мВ/дел От 0 до 200МГц, типичное
значение
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Связь по постоянному току 50 Ом, полная полоса пропускания, переходник TCA-292D,
рабочая температура <30 °C.

Расширение полосы пропускания (BWE) применимо к полномасштабным настройкам
62,5 мВФС, 100 мВФС, 200 мВФС, 500 мВФС и 1 ВФС.

Модель Настройка полосы
пропускания

Полоса
пропускания

Частота выборки

33 ГГц BWE
От 0 до >33 ГГц

100 Гвыб/сMSO/DPO73304DX,
<30 °C

Без BWE От 0 до >33 ГГц,
типичное значение

Все

25 ГГц BWE От 0 до >25 ГГц 100 Гвыб/сMSO/DPO72504DX,
<30 °C Без BWE От 0 до >25 ГГц,

типичное значение
Все

Расширение
полосы 23 ГГц

От 0 до >23 ГГц 50, 100 Гвыб/сMSO/DPO72304DX,
<30 °C

Без BWE От 0 до >23 ГГц,
типичное значение

50, 100 Гвыб/с

Частота колебани-
йтемпературы

Частота TC, (дБ/ °C)

Полоса
пропускания
аналогового
сигнала, модели
MSO/DPO70000DX

От 0 до 5 ГГц

10 ГГц

15 ГГц

20 ГГц

25 ГГц

30 ГГц

33 ГГц

0,005

0,010

0,025

0,045

0,065

0,115

0,160
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Модель Настройка полосы
пропускания

Полоса пропускания

20 ГГц BWE

20 мВ/дел, 50 мВ/дел,
100 мВ/дел и 250 мВ/дел

От 0 до >20 ГГц

100 мВ/дел, вся шкала
(10 мВ/дел)

От 0 до >18 ГГц

DPO72004C и
MSO72004C, <30 °C

Без BWE От 0 до >16 ГГц, типичное
значение

BWE От 0 до >16 ГГцDPO71604C и
MSO71604C, <30 °C Без BWE От 0 до >16 ГГц, типичное

значение

BWE От 0 до >12,5 ГГцDPO71254C и
MSO71254C, <45 °C Без BWE От 0 до >12,5 ГГц

BWE От 0 до >8 ГГцDPO70804C и
MSO70804C, <45 °C Без BWE От 0 до >8 ГГц

BWE От 0 до >6 ГГцDPO70604C и
MSO70604C, <45 °C Без BWE От 0 до >6 ГГц

BWE От 0 до >4 ГГцDPO70404C и
MSO70404C, <45 °C Без BWE От 0 до >4 ГГц

Частота
колебанийтемпературы

Частота TC, (дБ/ °C)

Полоса пропускания
аналогового сигнала,
модели MSO/DPO70000C

От 0 до 5 ГГц

10 ГГц

15 ГГц

20 ГГц

25 ГГц

30 ГГц

33 ГГц

0,005

0,010

0,025

0,045

0,065

0,115

0,160
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Связь по постоянному току с нагрузкой 50 Ом, полная полоса пропускания, допуск на
амплитуду –3 дБ, рабочие температуры ≤30 °C.
За каждый градус (°C) выше 30 °C необходимо уменьшать полосу пропускания на 1 %.

Модель Масштаб Полоса пропускания

От 10 мВ/дел. до 1 В/дел. От 0 до 2,00 ГГц

От 5 мВ/дел. до
9.98 мВ/дел.

От 0 до 1,5 ГГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

MSO5204B и DPO5204B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц

От 5 мВ/дел. до 1 В/дел. От 0 до 1,00 ГГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

MSO5104B и DPO5104B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц

От 5 мВ/дел. до 1 В/дел. От 0 до 500 МГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

MSO5054B и DPO5054B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц

От 2 мВ/дел. до 1 В/дел. От 0 до 350 МГц

Полоса пропускания
аналогового сигнала,
постоянный ток с
нагрузкой 50 Ом, модели
MSO5000B и DPO5000B

MSO5034B и DPO5034B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Связь по постоянному току с нагрузкой 1 МОм, полная полоса пропускания, допуск на
амплитуду –3 дБ, рабочие температуры ≤30 °C. За каждый градус (°C) выше 30 °C
необходимо уменьшать полосу пропускания на 1 %.

Модель Масштаб Полоса пропускания

От 5 мВ/дел. до 10 В/дел. От 0 до 500 МГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

MSO5204B и DPO5204B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц

От 5 мВ/дел. до 10 В/дел. От 0 до 500 МГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

MSO5104B и DPO5104B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц

От 5 мВ/дел. до 10 В/дел. От 0 до 500 МГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

MSO5054B и DPO5054B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц

От 5 мВ/дел. до 10 В/дел. От 0 до 350 МГц

От 2 мВ/дел. до
4,98 мВ/дел.

От 0 до 350 МГц

Полоса пропускания
аналогового сигнала,
постоянный ток с
нагрузкой 1 МОм, модели
MSO5000B и DPO5000B

MSO5034B и DPO5034B

От 1 мВ/дел. до
1,99 мВ/дел.

От 0 до 175 МГц
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

Полная полоса пропускания, допуск на амплитуду –3 дБ, рабочие температуры ≤30 °C.
За каждый градус (°C) выше 30 °C необходимо уменьшать полосу пропускания на 1 %.

Модель Масштаб Полоса пропускания

От 50 мВ/дел. до
100 В/дел.

От 0 до 1 ГГц (TPP1000)

От 0 до 500 МГц
(TPP0500/B)

От 20 мВ/дел. до
49,8 мВ/дел.

От 0 до 350 МГц

MSO5204B и DPO5204B

От 10 мВ/дел. до
19,9 мВ/дел.

От 0 до 175 МГц

От 50 мВ/дел. до
100 В/дел.

От 0 до 1 ГГц

От 20 мВ/дел. до
49,8 мВ/дел.

От 0 до 350 МГц

MSO5104B и DPO5104B

От 10 мВ/дел. до
19,9 мВ/дел.

От 0 до 175 МГц

От 50 мВ/дел. до
100 В/дел.

От 0 до 500 МГц

От 20 мВ/дел. до
49,8 мВ/дел.

От 0 до 350 МГц

MSO5054B и DPO5054B

От 10 мВ/дел. до
19,9 мВ/дел.

От 0 до 175 МГц

От 50 мВ/дел. до
100 В/дел.

От 0 до 350 МГц

От 20 мВ/дел. до
49,8 мВ/дел.

От 0 до 350 МГц

Полоса пропускания
аналогового сигнала с
пробниками TPP0500/B и
TPP1000

MSO5034B и DPO5034B

От 10 мВ/дел. до
19,9 мВ/дел.

От 0 до 175 МГц

Общее смещение = смещение - (положение х вольт/деление)

От 1 мВ/дел до 9,95
мВ/дел

±(0,2 % х | общее смещение | + 1,5 мВ + 0,1 дел х
значение В/дел)

От 10 мВ/дел до 99,5
мВ/дел

±(0,35 % х | общее смещение | + 1,5 мВ + 0,1 дел х
значение В/дел)

От 100 мВ/дел до 1 В/дел ±(0,35 % х | общее смещение | + 15 мВ + 0,1 дел х
значение В/дел)

От 1,01 В/дел до 10 В/дел ±(0,25 % × | общее смещение | + 150 мВ + 0,1 дел ×
значение В/дел)

Погрешность смещения

(Модели DPO7000C)

Погрешность
смещения

Значение В/дел
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Характеристика Описание

Погрешность смещения Модели с полосой
пропускания ≥4 ГГц

От 10 мВ/дел до 99,5 мВ/дел

Модели
MSO/DPO70000C

От 100 мВ/дел до 0,5
В/дел

±(0,35 % х | общее смещение | + 7,5 мВ + 0,1 дел х
значение В/дел)

Значение В/дел Погрешность смещения

Точность смещения Значение В/дел. Точность смещения

Модели
MSO/DPO70000DX

От 62,5 мВПС до
1,2 ВПС>От 1,2 ВПС до
6 ВПС

±(0,4 % × | общее смещение | +0,2 % × | общее
смещение – настройка Vterm | + 2,5 мВ + 1 % x полная
шкала)±(0,6 % × | общее смещение | + 13,4 мВ + 1 % x
полная шкала)

Погрешность смещения

(Модели MSO5000B и
DPO5000B)

±(0,005 × | смещение – положение | + баланс по постоянному току)

Максимальное входное
напряжение, 1 МОм,
модели DPO7000C

Снижение на 150 В при 20 дБ/декада до 9 Вср. квадр. более 200 кГц.

Максимальное входное напряжение на разъеме BNC между центральным
проводником и заземлением составляет 400 В. Среднеквадратичное значение
напряжения составляет не более <150 В для произвольных форма сигнала, включая
постоянный ток. Максимальная длительность для импульсов с пиковым напряжением
150 В составляет 50 μс. Пример. При пиковом значении от 0 до 400 В, прямоугольной
волне коэффициент заполнения составляет 14 %.

Максимальное неустановившееся выдерживаемое напряжение составляет ±800 В
(пиковое значение).

Максимальное входное
напряжение, 50 Ом,
модели DPO7000C

5 Вэфф., с пиковыми значениями не более ±24 В

Максимальное входное
напряжение, модели
MSO/DPO70000C

<1 Вэфф. и <2 В пост. тока + пик. напр. перем. тока для значений <1,0 В/ФС

<5,0 Вэфф. для значений ≥1 В ФС.

Максимальное входное
напряжение, модели
MSO/DPO70000DX

настройки ≤ 1,2 В/ПС:

±1,5 В относительно согласованной нагрузки со смещением (не более 30 мА).
Абсолютное максимальное входное значение ±5 В.

>настройки ≤ 1,2 В/ПС:

10 В при 25 °C со снижением до 8,4 В при 45 °C (ограничивается аттенюатором).
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

1 МОм 300 Вэфф. с пиковыми значениями не более ±425 В на
разъеме BNC

Категория установки II

Для <100 мВ/деление снижение со скоростью
20 дБ/декада при частотах выше 100 кГц до 30 В эфф.
при частоте 1 МГц, со скоростью 10 дБ/декада при
частотах выше 1 МГц.

Для ≥100 мВ/деление снижение со скоростью
20 дБ/декада при частотах выше 3 МГц до 30 В
эфф. при частоте 30 МГц, снижение со скоростью
10 дБ/декада при частотах выше 30 МГц.

Максимальное пиковое входное напряжение на разъеме
BNC, ±450 В

Максимальное входное
напряжение, модели
MSO5000B и DPO5000B

50 Ом 5 Вэфф., с пиковыми значениями не менее ≤±20 В
(скважность ≤6,25 %).
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Таблица 1: Характеристики входных каналов и разрешения по вертикали (прод.)

Характеристика Описание

MSO5204B и DPO5204B 1 МОм 50 Ом

Полная полоса
пропускания

≤(300 мкВ + 8% * масштаб
по вертикали)

≤(150 мкВ + 6% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 250 МГц

≤(120 мкВ + 5% * масштаб
по вертикали)

≤(75 мкВ + 4% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 20 МГц

≤(120 мкВ + 5% * масштаб
по вертикали)

≤(75 мкВ + 4% * масштаб
по вертикали)

MSO5104B и DPO5104B

Полная полоса
пропускания

≤(300 мкВ + 8% * масштаб
по вертикали)

≤(75 мкВ + 6% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 250 МГц

≤(100 мкВ + 5% * масштаб
по вертикали)

≤(50 мкВ + 4% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 20 МГц

≤(100 мкВ + 5% * масштаб
по вертикали)

≤(50 мкВ + 4% * масштаб
по вертикали)

MSO5054B и DPO5054B

Полная полоса
пропускания

≤(130 мкВ + 8% * масштаб
по вертикали)

≤(130 мкВ + 8% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 250 МГц

≤(100 мкВ + 6% * масштаб
по вертикали)

≤(100 мкВ + 6% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 20 МГц

≤(100 мкВ + 4% * масштаб
по вертикали)

≤(100 мкВ + 4% * масштаб
по вертикали)

MSO5034B и DPO5034B

Полная полоса
пропускания

≤(130 мкВ + 8% * масштаб
по вертикали)

≤(130 мкВ + 8% * масштаб
по вертикали)

Ограничение по
полосе пропускания
— 250 МГц

≤(100 мкВ + 6% * масштаб
по вертикали)

≤(100 мкВ + 6% * масштаб
по вертикали)

Случайный шум, режим
выборки, модели
MSO5000B и DPO5000B

Ограничение по
полосе пропускания
— 20 МГц

≤(100 мкВ + 4% * масштаб
по вертикали)

≤(100 мкВ + 4% * масштаб
по вертикали)
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Таблица 2: Характеристики систем горизонтальной развертки и оцифровки

Характеристика Описание

Точность долговременной
частоты дискретизации и времени
задержки

Модели DPO7000C ±2,5 х 10-6. Относительный уход частоты <1 х 10-6 в год с момента
заводской калибровки.

Действительно только при использовании внутреннего источника опорного
напряжения.

Модели MSO/DPO70000C ±1,5 х 10-6. Относительный уход частоты <1 х 10-6 в год с момента
заводской калибровки.

Действительно только при использовании внутреннего источника опорного
напряжения.

Модели MSO/DPO70000DX ±1,5 x 10-6 исходная точность. Относительный уход частоты <1 х 10-6 в
год с момента заводской калибровки.

Применимо только при использовании внутреннего опорного сигнала.

MSO5000B и DPO5000B ±5 х 10-6 на любом интервале длительностью не менее 1 мс.

Точность измерения
промежутков времени, модели
MSO/DPO70000C/DX

Ниже приведена формула для вычисления максимальной погрешности
измерения промежутков времени (DTAmax) по заданным параметрам
прибора и входного сигнала (предполагается, что доля сигнала,
превышающая частоту Найквиста, и погрешность из-за искажения
незначительны, предполагаются также восстановление после перегрузки
и интерполяция перегрузки):

SR1 = скорость нарастания сигнала вблизи первой точки измерения (1-й
фронт)

SR2 = скорость нарастания сигнала вблизи второй точки измерения (2-й
фронт)

FN = 1,3 для прибора с полосой пропускания ≤ 9 ГГц; 1,5 для прибора с
полосой пропускания ≥ 10 ГГц

Ntyp = типичная характеристика входного шума (вольты, ср.-квадр.
значение)

TBA = погрешность измерения времени развертки (2 промилле)

Fi=1,2×10–2

tr1=время нарастания первого фронта

tr2=время нарастания второго фронта

tj = джиттер/неопределенность апертуры выборки (около 250 фс для
продолжительности менее 10 мкс)

treading = измерение промежутка времени (с)

предполагается, что форма фронта определяется откликом фильтра
Гаусса
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Таблица 2: Характеристики систем горизонтальной развертки и оцифровки (прод.)

Характеристика Описание

Модели MSO/DSA/DPO70000C

Модели MSO/DPO70000DX

Среднеквадратичное значение гарантируется независимо от продолжительности сбора данных.

Модели MSO/DSA/DPO70000C

Модели MSO/DPO70000DX

Член под знаком квадратного корня характеризует устойчивость
измерений и связан со значением TIE (погрешность измерения
промежутков времени). Погрешности, обусловленные этим членом,
характеризуют измерение коротких одиночных импульсов. Второй член
связан с абсолютной погрешностью центральной частоты и устойчивостью
центральной частоты временной развертки и различается для измерений
коротких одиночных импульсов, выполняемых в течение определенного
интервала времени наблюдения (отсчитываемого от первого измерения
короткого одиночного импульса до последнего измерения короткого
одиночного импульса). Интервал наблюдения не может превышать
одного года.
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Таблица 2: Характеристики систем горизонтальной развертки и оцифровки (прод.)

Характеристика Описание

Для одного канала с амплитудой сигнала > 5 дел, с опорным уровнем
50 %, интерполяцией sin(x)/x, значением вольт/дел ≥ 5 мВ/дел, временем
нарастания/интервалом выборки >1,4 и <4. При измерении двух
каналов существует дополнительная погрешность, возникающая из-за
межканальных перекрестных помех.

Условия Погрешность

Одиночный сигнал, режим выборки
или высокого разрешения, полная
полоса пропускания

(0,06/частота дискретизации
+2,5 х 10-6 х | показание |)
среднеквадратичное значение

± (0,3/частота дискретизации +2,5
х 10-6 х |показание |) пиковое
значение

Погрешность измерения
промежутков времени

Модели DPO7000C

>100 усреднений, при полной
полосе частот (в реальном или
эквивалентном времени)

± (2,5 х 10-6 | показание | + 4 пс)
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Таблица 2: Характеристики систем горизонтальной развертки и оцифровки (прод.)

Погрешность измерения
промежутков времени, модели
MSO5000B и DPO5000B

Ниже приведена формула для вычисления погрешности измерения
промежутков времени (DTAmax) по заданным параметрам прибора и
входного сигнала (предполагается, что доля сигнала, превышающая
частоту Найквиста, и погрешность из-за искажения незначительны):

SR1 = скорость нарастания сигнала вблизи первой точки измерения (1й
фронт)

SR2 = скорость нарастания сигнала вблизи второй точки измерения (2й
фронт)

Ntyp = типичная характеристика входного шума (вольты, ср.-квадр.
значение)

TBA = погрешность измерения времени развертки (5 промилле)

tp = продолжительность измерения промежутка времени (с)

RD = (длина записи) / (частота дискретизации)

tsr = 1/ (частота дискретизации)

предполагается, что форма фронта определяется откликом фильтра
Гаусса

Член под знаком квадратного корня характеризует устойчивость
измерений, и он связан со значением TIE (погрешностью измерения
промежутков времени). Погрешности, обусловленные этим членом,
характеризуют измерение коротких одиночных импульсов. Второй член
связан с абсолютной погрешностью центральной частоты и устойчивостью
центральной частоты временной развертки и различается для измерений
коротких одиночных импульсов, выполняемых в течение определенного
интервала времени наблюдения (отсчитываемого от первого измерения
короткого одиночного импульса до последнего измерения короткого
одиночного импульса). Интервал наблюдения не может превышать одного
года.

Таблица 3: Технические характеристики синхронизации

Характеристика Описание

Все источники, для масштаба по вертикали от 10 мВ/дел до 1В/делЧувствительность
синхронизации по фронту,
связь по постоянному току,
стандартное значение

Источник синхронизации Чувствительность
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Таблица 3: Технические характеристики синхронизации (прод.)

Характеристика Описание

Основной запуск и запуск с
задержкой, К1 - К4

≤4 % x ФС, от 0 до 50 МГц

≤10 % x ФС при 4 ГГц

≤15 % x ФС при 6 ГГц

A: ≤20 % x ФС при 8 ГГц

A: ≤50 % x ФС при 11 ГГцB: ≤50 % x
ФС при 9 ГГц

20 % x ФС от 0 до полосы
пропускания прибора (типичное
значение, усовершенствованная
синхронизация включена,
автоматический режим — только для
частот выше 8 ГГц

Модели MSO/DPO70000DX и
MSO/DPO70000C

Дополнительный вход 250мВ, от 0 до 50МГц, с увеличением
до 350 мВ при 1 ГГц

Основной запуск и запуск с
задержкой, К1 - К4

≤0,7 дел от 0 до 50 МГц

≤1,2 дел при 2,5 ГГц

≤2,5 дел при 3,5 ГГц

Дополнительный вход 1 МОм: 250 мВ от 0 до 50 МГц, с
увеличением до 350 мВ при 250 МГц

50 Мом: 150 мВ от 0 до 50 МГц, с
увеличением до 200 мВ при 1,8 ГГц

Модели DPO7000C

Видеосинхронизация, К1 - К4 От 0,6 до 2,5 делений от пика
синхроимпульса видеосигнала

Основной запуск и запуск с
задержкой, К1–К4

≤0,4 дел. от 0 до 50 МГц, с
увеличением на 1 деление на полосе
пропускания прибора

Дополнительный вход 200 мВ от 0 до 50 МГц, с увеличением
до 500 мВ при 250 МГц

Модели MSO5000B и
DPO5000B

Видеосинхронизация, К1–К4 От 0,6 до 2,5 делений от пика
синхроимпульса видеосигнала

Диапазон времени Погрешность

<1 μс (стандартное значение<2 нс) ±(20 % от значения параметра +
0,5 нс)

Временная погрешность
синхронизации

Модели DPO7000C

От 1 μс до 1 с ±(0,01 % от значения параметра +
100 нс)
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Таблица 3: Технические характеристики синхронизации (прод.)

Характеристика Описание

Диапазон времени Погрешность

Синхронизация по глитчу и ширине. Погрешность TB есть погрешность
временной развертки, выраженная в процентах от параметра настройки.

От 300 пс до 1,01 мкс (от 300 пс до
1,0 нс, типичное значение)

± (3 % от значения + 80 пс)

От 1,02 мкс до 1 с ± (погрешность TB +100 нс)

Другие типы по времени

От 300 пс до 1,01 мкс (от 300 пс до
1,0 нс, типичное значение)

± (5 % от значения + 200 пс)

Временная погрешность
синхронизации

Модели MSO/DPO70000DX и
MSO/DPO70000C

От 1,02 мкс до 1 с ± (погрешность ВР +20 нс)

Флуктуации запуска
(среднеквадратичное значение)

Модели MSO/DPO70000DX и MSO/DPO70000C: 100 фс с применением
усовершенствованного запуска. Среднеквадратичное значение 1,0 пс (как
правило) для низкой частоты, сигнал с быстрым временем нарастания, фронт
A, задержка времени = 30 мкс.

Модели DPO7000C: 1,5 пс, среднеквадратичное значение (типичное)

Модели MSO5000B и DPO5000B:≤10 пс, ср. кв. значение, для синхронизации
по фронту≤100 пс, ср. кв. значение, для синхронизации не по фронту

Для низкой частоты, быстро нарастающий по времени сигнал.

Таблица 4: Технические характеристики последовательной развертки (необязательные параметры)

Характеристика Описание

Пределы скорости передачи
высокоскоростного запуска по
сигналам последовательных
шин NRZ (типичное значение)

Модели MSO/DPO70000DX и MSO/DPO70000C: до 1,25 Гбоддо 6,25 Гбод,
зашифрованные несбрасываемые данные 8B/10B, как правило, выше 1,25 Гбод
Требуется опция ST6G.

Модели DPO7000C: До 1,25 Гбод. Требуется опция ST1G.

Диапазон восстановления
тактовой частоты, модели
MSO/DPO70000DX,
MSO/DPO70000C

От 1,5 Мбод до 3,125 Гбод. При частоте выше 1250 МГц тактовый сигнал
доступен только в качестве внутреннего источника развертки. При частоте
ниже 1250 МГц тактовый сигнал доступен также на выходе восстановленного
синхроимпульса вместе с восстановленными данными.

Диапазон восстановления
тактовой частоты, модели
DPO7000С

От 1,5 Мбод до 1,25 Гбод.

Таблица 5: Характеристики цифровой регистрации (приборы серии MSO70000C)

Характеристика Описание

Минимальная регистрируемая
ширина импульса (базовый блок и
логический пробник)

<400 пс

Количество каналов пробника 17

Количество каналов регистрации
цифровых данных

16

Разрешение цифрового канала 1 бит, 0 или 1
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Таблица 5: Характеристики цифровой регистрации (приборы серии MSO70000C) (прод.)

Характеристика Описание

Разброс логических пороговых
значений

с пробником P6780

с пробником P6717

От –2 до 4,5 В

От –1,5 до 4,0 В

Разрешение логического порога 5 мВ

Погрешность измерения
логического порога (с
присоединенным пробником)

≤3 % порогового значения ±75 мВ

Количество цифровых каналов,
доступное для одновременной
регистрации аналоговых сигналов

4. Любой из 16 каналов регистрации
+ канал тактовых импульсов могут
отображаться вместо любого
аналогового канала прибора с
функцией iCapture.

Выходной сигнал запуска системы
распознавания слов может
быть источником отображения
аналогового сигнала.

Полоса пропускания с пробником
общего назначения

>300 МГц

Полоса пропускания с впаиваемым
дифференциальным пробником

>2,5 ГГц

Время нарастания с впаиваемым
дифференциальным пробником

≤200 пс

Диапазон расположения
аналоговых сигналов iCapture

±5 делений

Точность аналогового сигнала
постоянного тока iCapture (базовый
блок и пробник)

±(5 % от значения +0,2 деления)

Диапазоны усиления аналоговых
каналов с пробником

250мВ/дел, 375мВ/дел, 750мВ/дел,
1,25 В/дел, 1,88 В/дел, 3,75 В/дел

Значения для сравнения цифровых
каналов

0, 1 или безразличное состояние

Комбинационный запуск AND (И), NAND (НЕ-И), OR (ИЛИ),
NOR (НЕ-ИЛИ)

Комбинационный запуск с учетом
фронта

AND (И), NAND (НЕ-И), OR (ИЛИ), NOR (НЕ-ИЛИ) с учетом нарастающего,
нисходящего фронта или любого фронта CQ, квалификационный канал

Частота переключения триггера
устройства распознавания слов

≥1,5 ГГц

Дрожание запуска одиночного
канала

5 пс ср.квадр. для синхронизации
по фронту события A с
использованием низкочастотного
сигнала с быстрым временем
нарастания
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Таблица 5: Характеристики цифровой регистрации (приборы серии MSO70000C) (прод.)

Характеристика Описание

Точность порога низкоскоростной
последовательной синхронизации

±(3 % настройки +125 мВ) относительно входа наконечника пробника +
20 мВ/°C от рабочей температуры компенсация сигнального тракта (SPC).

Разброс пороговых значений
низкоскоростной последовательной
синхронизации

От –2 до 4,5 В с пробником P6780

От –1,5 до 4 В с пробником P6717A

Максимальная частота выборки при
регистрации цифрового сигнала

12,5 Гвыб/с

Таблица 6: Характеристики цифровой регистрации (приборы серии MSO5000B)

Характеристика Описание

Диапазон порогового напряжения От – 40 до 40 В

Погрешность логического порога ± (100 мВ + 3 % от порогового значения после
калибровки)

Входные каналы 16, цифровые

Разрешение цифрового канала 1 бит

Частота цифровой выборки

Главная:

MagniVu:

500 Мвыб./с (разрешение 2 нс)

16,5 Гвыб./с (разрешение 60,6 пс)

Входное сопротивление 100 кОм ± 1,0%

Входная емкость 3,0 пФ

Размах входного сигнала

Минимум 400 мВ размах

Максимальная 30 В размах, ≤200 МГц (с центром около порогового
напряжения постоянного тока) на наконечнике пробника

10 В размах, ≥200 МГц (с центром около порогового
напряжения постоянного тока) на наконечнике пробника

Пользовательский диапазон пороговых значений ±40 В

Минимальная определяемая длительность импульса 1 нс

Максимальная частота переключения на входе 500 МГц

Временное разрешение цифрового канала 2 нс главная память, 60,6 пс память MagniVu
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Таблица 7: Технические характеристики портов ввода/вывода

Характеристика Описание

Разъем BNC на передней панели; для подсоединения пробника требуется
подключение устройства для калибровки и компенсации пробника

Выходное напряжение Частота

Компенсация выходного
напряжения пробника, сдвиг
по напряжению и частота,
моделей MSO/DPO70000DX,
MSO/DPO70000C 810 мВ ± 22 % на нагрузке ≥ 10 кОм

(типичные значения — Vol = –0,25 В,
Voh = 0,56 В)

440 мВ ± 22 % на нагрузке 50 Ом
(типичные значения Vol = –0,14 В,
Voh = 0,30 В)

1 кГц ±20 %

Разъем BNC на передней панели; для подсоединения пробника требуется
подключение устройства для калибровки и компенсации пробника

Выходное напряжение Частота

Компенсатор пробника:
выходное напряжение и частота,
модели DPO7000C

1,0 В ±1,5 % на нагрузке ≥ 100 кОм

(стандартные значения Voh = 0 В, Vol
= -1,0 В)

1 кГц ±5 %

Выходное напряжение ЧастотаКомпенсатор пробника:
выходное напряжение, сдвиг по
напряжению и частота, модели
MSO5000B и DPO5000B

От 0 до 2,5 В ±2,0 % на нагрузке ≥
1 кОм

1 кГц ± 25 %

Разъем BNC на задней панели: импульсы, совместимые с уровнями TTL (с
выбором полярности) для сигналов синхронизации «A» или «B» (на выбор)

Vвых, высокий уровень Vвых, низкий уровень (истина)

Уровни сигналов на
вспомогательных выходах

≥2,5 В на нагрузке 1 МОм

≥1,0 В на нагрузке 50 Ом для
заземления

≤0,7 В на нагрузке 1 МОм

≤0,25 В на нагрузке 50 Ом для
заземления
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Технические характеристики

Таблица 7: Технические характеристики портов ввода/вывода (прод.)

Характеристика Описание

Выход внутреннего
эталонного сигнала

Частота Модели MSO/DPO70000DX и
MSO/DPO70000C:

Модели DPO7000C:

Модели MSO5000B и DPO5000B:

10 МГц

10 МГц

10 МГц

Стандартное значение
выходного напряжения

Vвых, высокий уровень Vвых, низкий уровень (истина)

Модели DPO7000C: Не менее 2,5 В при разомкнутой цепи

Не менее 1,0 В при нагрузке 50 Ом

Не более 0,7 В при втекающем токе
не более 4 мА

Не более 0,25 В при нагрузке 50 Ом

Модели
MSO/DPO70000C/DX:

≥ 750 мВ размах на нагрузке 50 Ом

≥ 1,5 В размах на нагрузке 1 МОм

Таблица 8: технические характеристики источника питания

Характеристика Описание

Потребляемая мощность Модели MSO/DPO70000DX и MSO/DPO70000C: ≤ 1200 ВА

Модели DPO7000C: Не более 550 Вт

Модели MSO5000B и DPO5000B: Не более 275 Вт

Напряжение и частота источника

Модели MSO/DPO70000DX и
MSO/DPO70000C

От 100 до 240 Вср. квадр., от 50 Гц до 60 Гц

115 В ±10 %, 400 Гц

Категория II

Модели DPO7000C От 100 до 240 Вср.квадр. ±10 %, от 47 до 63 Гц

115 В ±10 %, 400 Гц

Модели MSO5000B и
DPO5000B

От 100 до 240 Вэфф. ±10 %

От 85 до 264 В, от 45 до 66 Гц

От 100 до 132 В, от 360 до 440 Гц

Таблица 9: Механические характеристики

Характеристика Описание

Масса

Модели DPO7000C

Настольный блок

14,0 кг - только осциллограф

21,8 кг - набор в упаковке для местной транспортировки

Набор для монтажа в
стойку

0,9 кг

2,2 кг — набор в упаковке для внутренних перевозок

Модели DPO7000C/DX

Настольный блок

20 кг - только осциллограф

34 кг - набор в упаковке для местной транспортировки
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Таблица 9: Механические характеристики (прод.)

Характеристика Описание

Набор для монтажа в
стойку

2,04 кг

3,4 кг - набор в упаковке для местной транспортировки

Модели MSO70000C/DX

Настольный блок

25 кг — только осциллограф

9 кг — набор в упаковке для внутренних перевозок

Набор для монтажа в
стойку

2,04 кг

3,4 кг – набор в упаковке для внутренних перевозок

Модели MSO5000B и
DPO5000B

Настольный блок
6,8 кг — только осциллограф

9,5 кг — набор в упаковке для внутренних перевозок

Набор для монтажа в
стойку

8,7 кг — осциллограф вместе со стойкой

Размеры

С передней крышкой и ножками Без передней крышки и ножекМодели DPO7000C

Настольный блок высота 295,4 мм

ширина 468,6 мм

глубина 318,0 мм

высота 278,0 мм

ширина 450,8 мм

глубина 308,6 мм

С монтажом в стойке высота 311,15 мм

ширина 482,6 мм

глубина 520,7 мм

С передней крышкой и ножками Без передней крышки и ножекМодели MSO/DPO70000DX и
MSO/DPO70000C

Настольный блок
292 мм высота

Ширина - 451 мм

Глубина - 489,97 мм

278 мм высота

Ширина - 451 мм

Глубина - 489,97 мм

С монтажом в стойке высота 267 мм

502 мм ширина

глубина 489 мм

Модели MSO5000B и
DPO5000B

Настольный блок

высота 236 мм, включая ножкивысота 249 мм, включая вертикальную ручку
и ножки

ширина 439 мм

глубина 203 мм, от ножек до регуляторов на передней панелиглубина 226 мм,
от задней ручки до регуляторов на передней панели

С монтажом в стойке высота 218 мм

ширина 488 мм, от внешней части одной ручки до внешней части другой ручки

глубина 384 мм, от внешней части ручки до задней части направляющей

Охлаждение Принудительная вентиляция без воздушного фильтра.
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Таблица 9: Механические характеристики (прод.)

Характеристика Описание

Сверху 0 мм

Снизу 0 мм при установке на ножки с
откинутыми стойками

Слева 76 мм

Справа 76 мм

Минимальные расстояния от
стенок прибора

Модели
MSO/DPO70000DX и
MSO/DPO70000C

Сзади 0 мм (по задним ножкам)

Сверху 0 мм

Снизу 6,35 мм, 0 мм при установке на ножки
с откинутыми стойками

Слева 76 мм

Справа 0 мм

Модели DPO7000C

Сзади 0 мм (по задним ножкам)

Сверху 0 мм

Снизу 0 мм при установке на ножки с
откинутыми стойками

Слева 50,8 мм

Справа 0 мм

Модели MSO5000B и
DPO5000B

Сзади 50,8 мм

Материалы конструкции Элементы корпуса изготовлены из алюминиевых сплавов, передняя панель -
из слоистого пластика, а монтажные платы - из многослойного стекла.

Таблица 10: характеристики условий эксплуатации

Характеристика Описание

Температура

Модели
MSO/DPO70000DX
и MSO/DPO70000C

Рабочая От +5 °C до +45 °C, изменение не более 11 °C/час, без конденсации,
понижение на 1.0 °C каждые 300 м при высоте более 1500 м.

Хранение От -20 °C до +60 °C, изменение не более 20 °C/час, если не
установлен диск.

Модели DPO7000C Рабочая От +5 °C до +45 °C

Хранение От -40 °C до +71 °C, изменение не более 15 °C/час, если не
установлен диск.

Модели MSO5000B
и DPO5000B

При
эксплуатации

от 0 до +50 °C

При хранении От –20 °C до 60 °C

Влажность

Модели
MSO/DPO70000DX
и MSO/DPO70000C

Рабочая От 8% до 80 % относительной влажности при температуре до +32 °C

От 5 % до 45 % относительной влажности при температуре от +32 °C
до +45 °C, без конденсата, при ограничении температуры влажного
термометра +29,4 °C (относительная влажность снижается до 32 %
при температуре +45 °C)
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Технические характеристики

Таблица 10: характеристики условий эксплуатации (прод.)

Характеристика Описание

Хранение Относительная влажность от 5 % до 95 % при температуре до +30 °C,

От 5 % до 45 % при температуре от +30 °C до +60 °C, без конденсата,
при максимальной психрометрической температуре +29,4 °C
(относительная влажность снижается до 11 % при +60 °C)

Модели DPO7000C Рабочая От 8 % до 80 % относительной влажности при температуре влажного
термометра +29 °C, при температуре +45 °C (или ниже), без
конденсата

Верхний предел относительной влажности снижается до 30 % при
+45 °C

Хранение Относительная влажность от 5 % до 90 % при психрометрической
температуре не более +29 °C для температуры не более +60 °C, без
конденсата

Верхний предел относительной влажности снижается до 20 % при
+60 °C

Модели MSO5000B
и DPO5000B

При
эксплуатации

С твердотельным накопителем

Верхнее значение: от 40 до 50 °C при относительной влажности от
10 до 60 %

Нижнее значение: от 0 до 40 °C при относительной влажности от
10 до 90 %

При хранении С твердотельным накопителем

Верхнее значение: От 40 до 60 °C при относительной влажности от 5
до 60 %

Нижнее значение: От 0 до 40 °C при относительной влажности от 5
до 90 %

Высота над уровнем
моря

При работе Модели MSO/DPO70000DX и MSO/DPO70000C: До 9843 футов
(3000 м), на высоте более 4921,25 фута (1500 м) над уровнем моря
максимальная рабочая температура снижается на 1 °C на каждые
984,25 фута (300 м).

Модели DPO7000C: 3 000 м

Модели MSO5000B и DPO5000B: 3 000 м

При хранении Модели MSO/DPO70000DX и MSO/DPO70000C: 39370 футов
(12 000 м)

Модели DPO7000C: 12 192 м

Модели MSO5000B и DPO5000B: 9 144 м
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Приложение А

Чистка
Для чистки прибора используйте нижеуказанные процедуры. Если необходима дополнительная чистка, ее могут
выполнить квалифицированные специалисты по обслуживанию.

Чистка наружной поверхности

Чистка внешних поверхностей корпуса выполняется сухой тканью, не оставляющей волокон, или мягкой щеткой.
Оставшееся загрязнение может быть удалено тканью или щеткой, смоченной в 75-процентном растворе
изопропилового спирта. Узкие места вокруг элементов управления и разъемов следует прочищать щеткой. Не
используйте для очистки шасси абразивные составы.

Выключатель On/Standby (Вкл/Ожидание) следует очищать увлажненной чистящей салфеткой. Не наносите
очищающую жидкость непосредственно на выключатель.

ОСТОРОЖНО. Использование неподходящих способов чистки, чистящих средств или чрезмерные усилия могут
привести к повреждению прибора. Не используйте химические чистящие вещества, которые могут повредить
пластиковые элементы, используемые в осциллографе. При очистке кнопок меню или кнопок передней панели
используйте только деионизированную воду. При чистке 75-процентным раствором изопропилового спирта
остатки раствора следует удалять деионизированной водой. Перед использованием чистящих средств других
типов проконсультируйтесь с представителями и сервисным центром Tektronix.

Чтобы предотвратить попадание влаги внутрь прибора при внешней чистке, не используйте жидкости больше,
чем это необходимо для увлажнения ткани или аппликатора.
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Приложение B

Получение последнего приложения осциллографа и выпусков версий
Последняя версия дополнительно заказанного вместе с прибором приложения, может быть на нем не установлена.
Приведенная ниже ссылка для загрузки — самый быстрый и простой способ получения новейшей версии программы.

Чтобы скачать самую последнюю версию программы, зайдите на домашнюю страницу веб-сайта Tektronix
(www.tektronix.com) и найдите на ней раздел Downloads (загрузить). В текстовом окне ENTER MODEL NUMBER
(введите номер модели) введите название приложения и в ниспадающем меню Select Download Type (выберите тип
загружаемого материала) выберите пункт Software (программное обеспечение).

ПРИМЕЧАНИЕ. Находящийся на веб-странице файл Release Notes (Заметки о выпуске) может содержать
больше свежей информации, чем файл readme.txt, содержащийся в загружаемом исполняемом файле.

Для определения критериев поиска используйте название приложения в текстовом окне ENTER MODEL NUMBER
(введите номер модели). Например, используйте ключевое слово DPOJET для поиска и загрузки последней версии
приложения DPOJET.

Если приложение было приобретено вместе с прибором, лицензионный ключ Tektronix позволит это приложение
использовать.

Чтобы активировать приложение после его обновления, следуйте инструкциям раздела «Как установить новый
лицензионный ключ Tektronix» в файле Readme.txt.

Руководство по эксплуатации для приборов серий MSO/DPO70000DX, MSO/DPO70000C, DPO7000C и MSO/DPO5000B 229



Приложение C

Приложение C

Инструкции по эксплуатации пассивных пробников TPP0500 и TPP1000,
500 МГц и 1 ГГц, 10X

071-2809-xx

© Tektronix, Inc., Все права защищены.

Сведения по эксплуатации
Пробники TPP0500B и TPP1000 10X — компактные пассивные пробники с 10-кратным ослаблением, которые
предназначены для использования с осциллографами Tektronix серий MSO/DPO4000B & 5000B.

Эти пробники не содержат обслуживаемых пользователем или компанией Tektronix деталей.

Подсоединение пробника к осциллографу
Подключите пробник, как показано на рисунке внизу.
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Компенсация пробника
MSO/DPO5000B. Для компенсации пробника выполните следующие действия:

1. Подключите пробник к каналу осциллографа.

2. Подключите пробник к выходным клеммам компенсации пробника на передней панели осциллографа.

3. Выберите Vertical > Probe Cal (по вертикали > калибровка пробника).

4. Выберите вкладку, соответствующую каналу, к которому присоединен пробник.

5. В разделе меню Probe Compensation (Компенсация пробника) нажмите кнопку Compensate Probe
(Компенсировать пробник).

ПРЕДУПРЕЖДЕНИЕ. Во избежание удара электрическим током подключайтесь к сигналу Probe Comp
(компенсация пробника) осциллографа только при выполнении данной настройки.

Если компенсацию пробника выполнить не удалось, проследите, чтобы сигнальная шина и провод заземления были
надежно подсоединены к контактам Probe Comp (компенсация пробника) на осциллографе. Проверьте также,
чтобы провод заземления и наконечник жесткого штифта или штифта «pogo» были надежно закреплены в головке
пробника, а крючок был надежно соединен с наконечником.

Стандартные принадлежности
Ниже показаны стандартные принадлежности, входящие в комплект пробника.

ПРЕДУПРЕЖДЕНИЕ. Во избежание поражения электрическим током при использовании пробника или его
принадлежностей прикасайтесь к корпусу пробника или его принадлежности только выше предохранительного
кольца.

Пункт Описание

Наконечник с захватом

Наденьте наконечник с захватом на наконечник
пробника и зафиксируйте захват на цепи.

Номер по каталогу Tektronix для повторного
заказа — 013-0362-XX

Миниатюрный наконечник с захватом

Этот наконечник используется для доступа
к контрольным точкам в условиях дефицита
пространства. Наденьте наконечник с захватом
на наконечник пробника и зафиксируйте захват
на цепи.

Номер по каталогу Tektronix для повторного
заказа — 013-0363-XX
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Пункт Описание

Жесткий штифт

Этот тип наконечника установлен на пробнике
заранее.

Номер по каталогу Tektronix для повторного
заказа — 206-0610-XX

Штифт «pogo»

Этот тип подпружиненного наконечника
позволяет производить удовлетворяющее
определенным требованиям тестирование
монтажных плат.

Номер по каталогу Tektronix для повторного
заказа — 206-0611-XX

Провод заземления с зажимом типа
«крокодил»

Прикрепите этот провод к «земле» головки
пробника, а затем — к «земле» исследуемой
цепи.

Номер по каталогу Tektronix для повторного
заказа — 196-3521-XX

Заземляющие пружины

Прикрепите пружину к кольцу заземления
наконечника пробника для проведения
измерений в контрольных точках, которые
поблизости имеют заземляющие соединения
(<19 мм, стандарт; XX мм, короткая).

Номера по каталогу Tektronix для повторного
заказа:

016-2028-XX (длинная, 2 шт.)

016-2034-XX (короткая, 2 шт.)
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Дополнительные принадлежности
Для пробника можно заказать следующие принадлежности.

Принадлежность Номер по каталогу Tektronix

Провод заземления с зажимом, 15,2 см 196-3198-xx

Провод заземления с зажимом «крокодил», 30,5 см 196-3512-xx

Наконечник пробника MicroCKT 206-0569-xx

Измерительный наконечник печатной платы/адаптер печатной
платы

016-2016-xx

Измерительный наконечник печатной платы для компактного
наконечника пробника

131-4210-xx

Проводник, катушка, 32 AWG 020-3045-xx

Замена наконечника пробника
Закажите по каталогу Tektronix деталь с номером 206-0610-xx для замены жесткого штифта или деталь с номером
206-0611–xx для замены штифта «pogo».

Технические характеристики
Таблица 11: Электрические и механические характеристики

Характеристика TPP0500/B TPP1000

Полоса пропускания (–3 дБ) 500 МГц 1 ГГц

Время нарастания системы (типичное значение) < 350 пс < 700 пс

Входная емкость системы Жесткий штифт: 3,9 ± 0,3 пФ
Штифт «pogo»: 5,1 ± 0,5 пФ

Погрешность ослабления системы 10:1 ±2.2%

Добавочное сопротивление пробника при постоянном токе 9,75 МОм ± 0,5 %

Входное сопротивление системы при постоянном токе 10 МОм ± 2%

Задержка распространения ~5,67 нс

Максимальное входное напряжение 300 Вср.кв. КАТ. II

Длина кабеля 1,3 м ± 3 см
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Графики рабочих характеристик

При проведении измерений в режиме изоляции от цепей заземления пользуйтесь приведенной выше кривой
снижения параметров опорного вывода.

Таблица 12: Условия эксплуатации

Характеристики Описание

Температура

При эксплуатации

При хранении

От –15 до 65 °C

От –62 до 85 °C

Влажность

При эксплуатации

При хранении

Относительная влажность от 5 до 95 % при температуре до 30 °C

Относительная влажность от 5 до 45 % при температуре от 30 до 50 °C

Высота над уровнем моря

При эксплуатации

При хранении

4,6 км, максимальная

12,2 км, максимальная

234 Руководство по эксплуатации для приборов серий MSO/DPO70000DX, MSO/DPO70000C, DPO7000C и MSO/DPO5000B



Приложение C

Таблица 13: Сертификация и соответствие стандартам

Характеристики Описание

Соответствие стандартам
по электромагнитной
совместимости для
Евросоюза

Проверено на соответствие перечисленным ниже спецификациям (как указано в
Official Journal of the European Communities):

Директива 2006/95/EC по низковольтному оборудованию:

EN61010-031: 2002

Категория Примеры продуктов, относящихся к категории.

Категория III Линии электропередач, фиксированная установка

Категория II Линии питания в помещениях, бытовые электроприборы,
портативное оборудование

Описание категорий
измерений

Категория I Цепи, подключенные к линиям питания не напрямую

Уровень загрязнения 2 Не допускайте эксплуатации прибора в присутствии проводящих загрязняющих
веществ (как определяет стандарт IEC 61010-1). Прибор предназначен только для
использования в помещении.

Дополнительные
стандарты безопасности

Первое издание UL61010B-1 и первое издание UL61010B-2-031.

CAN/CSA-C22.2 No. 1010.1-92, и CAN/CSA-C22.2 No. 1010.2.031-94

IEC61010-031:2002

Утилизация оборудования. Этот прибор соответствует требованиям Европейского Союза согласно
Директиве 2002/96/EC об утилизации электрического и электронного оборудования (WEEE). Более
полные сведения об условиях утилизации см. в разделе технической поддержки на веб-узле Tektronix
(www.tektronix.com).

Общие положения о безопасности
Во избежание травм, а также повреждений данного изделия и подключаемого к нему оборудования необходимо
соблюдать следующие правила техники безопасности. Используйте изделие в строгом соответствии с инструкциями,
чтобы исключить фактор риска. Использование пробника или его принадлежностей не по назначению может
привести к удару электрическим током или возгоранию.

Пожарная безопасность и предотвращение травм

Использование осциллографа для измерений относительно «земли». Не допускайте плавания
потенциала на опорном выводе этого пробника при использовании осциллографов для измерений относительно
«земли» (например, осциллографов серий DPO, MSO и TDS). Опорный вывод должен быть соединен с потенциалом
«земли» (0 В)

Соблюдайте правила подсоединения и отсоединения. Перед подсоединением пробника к тестируемой
системе подсоединяйте его выход к измерительному прибору. Перед отсоединением пробника от измерительного
прибора отсоединяйте его вход и опорный вывод от тестируемой системы.

Избегайте удара электрическим током. Во избежание травм, в том числе со смертельным исходом, не
подсоединяйте и не отсоединяйте пробники и провода, когда они подключены к источнику напряжения.

Проверяйте допустимые номиналы для всех разъемов. Во избежание воспламенения или поражения
электрическим током проверьте все допустимые номиналы и маркировку на приборе. Перед подсоединением
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прибора просмотрите дополнительные сведения по номинальным ограничениям, содержащиеся в руководстве
по эксплуатации прибора.

Избегайте удара электрическим током. При использовании принадлежностей пробника никогда не нарушайте
самый низкий номинал пробника или его принадлежности, независимо от того, какой из них ниже, включая категорию
измерений и номинальное напряжение.

Избегайте перегрузок электросети. Во избежание получения травм или опасности возгорания не
прикладывайте потенциал к какому-либо из входов, включая входы опорных сигналов, отличающихся от «земли»
более, чем на максимальный номинал данного входа.

Избегайте открытых электрических схем и не работайте с прибором при снятом кожухе. Не
прикасайтесь к неизолированным соединениям и компонентам, находящимся под напряжением.

Осматривайте пробник и принадлежности. Перед каждым использованием осматривайте пробник и
принадлежности на наличие повреждений (порезов, задиров, дефектов в корпусе пробника, принадлежностях,
рубашке кабеля и т. д.). При наличии повреждений откажитесь от их использования.

Не пользуйтесь прибором в условиях повышенной влажности.

Не пользуйтесь прибором во взрывоопасных средах.

Не допускайте попадания влаги и загрязнений на поверхность прибора.

Условные обозначения и символы, относящиеся к безопасности, используемые в данном
руководстве по эксплуатации

Ниже приводится список условных обозначений, используемых в данном руководстве по эксплуатации.

ПРЕДУПРЕЖДЕНИЕ. Предупреждения о действиях и условиях, представляющих угрозу для жизни или способных
нанести вред здоровью.

ОСТОРОЖНО. Предостережения о действиях и условиях, способных привести к повреждению данного прибора
или другого оборудования.

Символы, встречающиеся на изделии. Ниже приводится список символов на изделии.

Как связаться с компанией Tektronix

Веб-узел: www.tektronix.com

Телефон: 1-800-833-9200
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Адрес: Tektronix, Inc.
Отдел или имя (если известно)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Электронная почта: techsupport@tektronix.com

Гарантийные обязательства

Информацию о гарантийных обязательствах см. на веб-сайте www.tektronix.com/warranty
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Приложение D

Инструкции к логическому пробнику P6616 общего назначения
071-2831-00

© Tektronix, Inc., Все права защищены.

Описание прибора
Логический пробник P6616 общего назначения соединяет осциллографы смешанных сигналов Tektronix серий
MSO/DPO5000B и MSO4000B с шинами передачи данных и сигналов исследуемой системы. Пробник имеет 16
каналов передачи данных, распределенных между двумя наборами проводов (ГРУППА 1 и ГРУППА 2).

Первый провод каждого набора имеет изоляцию синего цвета, а остальные семь проводов — изоляцию серого
цвета. Все провода на конце оборудованы заземлением. Концы пробника можно подсоединять к исследуемой
системе по отдельности, а можно группировать их при помощи держателей наконечников пробника.
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Подсоединение пробника к осциллографу
Подсоедините пробник, как показано на рисунке внизу.

1. Вставьте пробник этикеткой вверх в разъем осциллографа.

2. Чтобы извлечь пробник, нажмите кнопку на его боковой поверхности и потяните его на себя.
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Подсоединение пробника к контуру
Присоедините пробник к цепи при помощи разъемов и адаптеров, изображенных на оборотной стороне данного
руководства по эксплуатации. Выберите наиболее подходящий метод, после чего перейдите к разделу «Настройка
пробника».

Настройка пробника

Для установки и просмотра параметров цифрового канала, выполните следующие действия.

На приборах серии MSO/DPO5000B выберите пункты меню Vertical>Digital Setup (по вертикали > установка
цифрового канала) или нажмите кнопку D15-D0.

На приборах серии MSO4000B нажмите кнопку D15–D0.

Для каждого цифрового канала могут быть установлены приведенные ниже параметры.

Пороговое напряжение и вертикальное положение (настройка порога по умолчанию равна 1,4 В)

Высота и положение сигнала (устанавливается один раз для всех 16 каналов)

Метка канала

Для настройки и просмотра характеристик шины выполните следующие действия.

На приборах серии MSO/DPO5000B используйте элементы управления меню Bus Setup (настройка шины).

На приборах серии MSO4000B нажмите кнопки B1 — B4.

Экраны настройки позволяют устанавливать и просматривать такие характеристики шины, как:

Тип синхронизации

Тип шины (последовательный или параллельный)

Ширина шины

Формат дисплея (шестнадцатиричный, двоичный или символы ASCII)

Информация по настройке параллельной шины содержится в памяти некоторых осциллографов. Однако для других
шин, таких как шины SPI и I2C, необходимо иметь соответствующий выбор. Подробнее о номенклатуре и порядке
оформления заказа см. в руководстве или спецификации своего осциллографа.
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Проверка работоспособности
Активность логики сразу же отображается на всех подсоединенных, активных каналах. Если активного сигнала не
видно:

1. Нажмите кнопку Trigger (синхронизация).

2. Выберите пункт Edge (фронт), чтобы установить тип синхронизации.

3. Выберите канал, который будет являться источником.

4. На приборах серии MSO4000B нажмите кнопку Autoset (автоустановка).

Если активного сигнала не видно, попробуйте использовать другой канал пробника (или аналоговый пробник), чтобы
проверить активность контура в контрольной точке.

Типичный способ применения
1. Используйте пробник P6616 для просмотра цифровых сигналов на системной шине.

2. Используйте аналоговый пробник, например пассивный пробник TPP0500/B или TPP1000, для просмотра
информации в виде аналоговой осциллограммы.
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Принадлежности
Следующие стандартные принадлежности поставляются вместе с пробником и показаны на рисунке, расположенном
на следующей странице.

Пункт Описание Количество Номер по каталогу

— Набор принадлежностей логического пробника Пункт 1—6 020-2662-XX

1 Удлинительный наконечник для заземления 1 комплект из 20 020-2711-XX

2 Наконечник пробника 1 комплект из 10 131-5638-11

3 Захват для ИС 1 комплект из 20 020-2733-XX

4 Держатель наконечника пробника 2 шт. 352-1115-XX

5 Провод заземления 203 мм 1 комплект из 2 020-2713-XX

6 Провод заземления 76 мм 1 комплект из 8 020-2712-XX

Руководство по эксплуатации 1 1 шт. 071-2831-XX

1 Руководство по эксплуатации входит в комплект пробника, но не входит в комплект принадлежностей. Руководство по эксплуатации
можно также загрузить на веб-сайте www.tektronix.com/manuals.

Для пробника можно заказать следующие дополнительные принадлежности:

Описание Номер по каталогу

Опорная площадка D-MAX пробника P6960 для адаптера с
квадратными контактами

NEX-P6960PIN
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Технические характеристики

Таблица 14: Электрические и механические характеристики

Характеристика Описание

Входные каналы 16, цифровые

Входное сопротивление 100 кОм ± 1,0%

Входная емкость 3,0 пФ

Размах входного сигнала

Минимум 400 мВ размах

Максимальная 30 В размах, ≤200 МГц (с центром около порогового напряжения
постоянного тока) на наконечнике пробника

10 В размах, ≥200 МГц (с центром около порогового напряжения
постоянного тока) на наконечнике пробника

Максимальный нераз–рушающий
входной сигнал

±42 В

Пользовательский диапазон пороговых
значений

±40 В

Минимальная определяемая
длительность импульса

1 нс

Сдвиг между цифровыми каналами 200 пс

Длина пробника 1,3 м

Таблица 15: Условия эксплуатации

Характеристика Описание

Температура

При эксплуатации От 0 до 50 °C

При хранении От –55 до 75 °C

Влажность

При эксплуатации относительная влажность от 5 до 95 %

При хранении относительная влажность от 10 до 95 %

Высота над уровнем моря

При эксплуатации 4,6 км, максимальная

При хранении 15 км, максимальная

Утилизация оборудования. Этот прибор соответствует требованиям Европейского Союза согласно
Директиве 2002/96/EC об утилизации электрического и электронного оборудования (WEEE). Более
полные сведения об условиях утилизации см. в разделе технической поддержки на веб-узле Tektronix
(www.tektronix.com).
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Общие положения о безопасности
Используйте пробник в строгом соответствии с инструкциями, чтобы исключить фактор риска.

Соблюдайте правила подсоединения и отсоединения. Перед подсоединением пробника к тестируемой
системе подсоединяйте его выход к измерительному прибору. Перед отсоединением пробника от измерительного
прибора отсоединяйте его вход и провод заземления от тестируемой системы.

Проверяйте допустимые номиналы для всех разъемов. Во избежание воспламенения или поражения
электрическим током проверьте все допустимые номиналы и маркировку на приборе. Перед подсоединением
прибора просмотрите дополнительные сведения по номинальным ограничениям, содержащиеся в руководстве
по эксплуатации прибора.

Не используйте прибор с открытым корпусом. Не прикасайтесь к неизолированным соединениям и
компонентам, находящимся под напряжением.

Избегайте прикосновений к оголенным участкам цепи. Не прикасайтесь к неизолированным соединениям
и компонентам, находящимся под напряжением.

Не пользуйтесь неисправным прибором. Если у вас возникло предположение о возможной неисправности
прибора, попросите квалифицированного специалиста сервисного центра проверить его.

Не пользуйтесь прибором в условиях повышенной влажности. Не пользуйтесь прибором во
взрывоопасных средах.

Не допускайте попадания влаги и загрязнений на поверхность прибора.

Условные обозначения и символы, относящиеся к безопасности,
используемые в данном руководстве по эксплуатации

Ниже приводится список условных обозначений, используемых в данном руководстве по эксплуатации.

ПРЕДУПРЕЖДЕНИЕ. Предупреждения о действиях и условиях, представляющих угрозу для жизни или способных
нанести вред здоровью.

ОСТОРОЖНО. Предостережения о действиях и условиях, способных привести к повреждению данного прибора
или другого оборудования.

Символы, встречающиеся на изделии. Ниже приводится символ, встречающийся на изделии:
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Приложение D

Как связаться с компанией Tektronix
Веб-узел: www.tektronix.com

Телефон: 1-800-833-9200

Адрес: Tektronix, Inc.
Отдел или имя (если известно)
14200 SW Karl Braun
Drive P.O. Box 500
Beaverton, OR 97077
USA

Электронная почта: techsupport@tektronix.com

Гарантийные обязательства
Информацию о гарантийных обязательствах см. на веб-сайте www.tektronix.com/warranty.
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Приложение D

Подсоединение пробника к цепи
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А
автопрокрутка, 114, 116
Анализ осциллограмм, 135
Анализ DDR, 129

Б
бесконечное послесвечение, 103
блокировка увеличенных участков

осциллограммы, 114, 116
Быстрая регистрация, 48, 192

В
В-курсор, 146
векторы

стиль отображения
осциллограмм, 102

взаимодействия режима
прокрутки, 53

Видео
Строки, 199

Видеосинхронизация, 198
определение, 81

Визуальный запуск, 95
включение питания, 7
Воспроизведение-пауза,

режим, 119
Восстановление операционной

системы, 15
Вход сигнала, 34
Выбор типа запуска, 78
выборка

в реальном времени, 39
в эквивалентном времени, 40
с интерполяцией в реальном

времени, 39
Выборки повышенной яркости

стиль отображения
осциллограмм, 102

Выбросы
регистрация, 42, 48, 192
синхронизация по, 77

выключение питания, 9

Г
Г-курсор, 146

Гистограмма
сохранение, 185

Горизонтальный маркер, 113
Горизонтальный режим

выбор, 45

Д
дата и время, 108
Два монитора, 12
Действие по событию

настройка, 97
Детектор ошибок, 156
Детектор последовательных

ошибок, 156
диагностика, 31
Дисплей

объекты, 108
Дистанционный дисплей, 11
Добавление фильтрации

пользовательская, 151
Документация, xvii
Дополнительная

документация, xvii
дополнительные измерения, 139

З
Загрузить

настройку, 182
осциллограммы, 179

Загрузка
настройки прибора, 182
осциллограммы, 179

Задержка по горизонтали, 101
Замок с тросиком, 11
Записи большой длины

управление, 117
запись сигнала

определение, 41

Запуск
выдержка, 77
интервал до запуска, 76, 77
интервал после запуска, 76,

77
наклон, 77
основные понятия, 76
принудительный, 76
режимы, 76
тип входа, 77
уровень, 77
экранная надпись, 83

запуск по видеосигналу
определение, 80

запуск по выбросу
определение, 80

запуск по длительности
определение, 80

запуск по истечении заданного
времени
определение, 80

запуск по модели
определение, 81

запуск по огибающей
определение, 80

Запуск по окну
определение, 80

запуск по переходу
определение, 80

запуск по состоянию
определение, 81

запуск по установке/фиксации
определение, 81

запуск регистрации, 45
Запуск RS-232

определение, 81

И
измерения, 135

курсорные, 146
опорные уровни, 145
определение, 137
снимок, 143, 144
статистики, 143

Измерения
комментарий, 144
настройка, 142
точность, 38
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измерения амплитуды, 137
измерения времени, 138
измерения по гистограммам, 139
Инструкция

выполнение поиска и
добавление меток на
осциллограмме, 120

Интервал до запуска, 76, 77
Интервал запуска

последовательная шина, 197
Интервал после запуска, 76, 77
интерполяция, 41, 105
интерполяция функцией

sin(x)/x, 105
Источник питания, 7

К
Как

использование режима
MagniVu, 63

использовать функции Wave
Inspector, 117

работать с осциллограммами
при большой длине
записи, 117

Калибровка, 32
Кнопка

Воспроизведение-пауза, 119
Установить/сбросить

метку, 121
D15-D0, 63

Кнопка воспроизведения-
паузы, 119

Кнопка установки и сброса
меток, 121

компьютерная сеть,
подключение, 11

Контекстное меню, 30
Копирование, 187
курсорные измерения, 146

Л
Линейная интерполяция, 105
логический анализатор

сопоставление данных, 200
Лупа, 111

М
маркеры уровня

синхронизации, 108

маска
автоподбор, 164
автоустановка, 164, 166
пределы допуска, 165
сохранение, 184
тест «пройден-сбой», 165

масштаб по горизонтали
и расчетные

осциллограммы, 152
масштабирование, 117

размер сетки, 118
регулятор, 117

масштабная сетка, стили, 107
Математический функции

осциллограмм, 150
произвольные фильтры, 151
редактор, 150
цвета, 111

Меню, 30
Меню, появляющееся при щелчке

правой кнопкой мыши, 30
метка, 106
Метка

цифровой канал, 55
шина, 56
экранные сообщения, 106

Метка времени
сохранение, 186

Метки, 120, 121, 123
Метки времени, 67

определение, 65

Н
наложение кадров, 67
Напряжение согласованной

нагрузки, 52
настройка гистограммы, 148
настройка по умолчанию, 36
несколько увеличенных

участков, 113

О
объекты

экран, 108
Обычный режим

синхронизации, 76
ограничение полосы

пропускания, 51
одиночный запуск, 45
опорные уровни, 145
Основная синхронизация, 77, 83

остановка регистрации, 45
осциллогр.

курсоры, 146
поиск и метки, 120
пользовательские метки, 120

осциллограмма
анализ, 135
экран, 102

Осциллограмма
воспроизведение, 118
воспроизведение-пауза, 119
масштабирование, 117
панорамирование, 117, 118
пауза, 118

Отключение питания, 10
отмена автоустановки, 38
отмена последней

автоустановки, 38
Отображение

объекты, 108
послесвечение, 103
стиль, 102
цвета, 110

П
палитра отображения записи, 109
Панель управления, 17
панорамирование, 117, 118

регулятор, 118
Параллельная, 197
Первоначальная проверка, 31
переменное послесвечение, 103
Печатная копия, 189
Печать, 189
Питание

отключение, 10
по линии связи

запуск, определение, 81
измерения, 140

Поиск, 120, 121, 123
Положение запуска, 86
Положение по вертикали, 35
положение по вертикали и

автоустановка, 38
положение по горизонтали

и расчетные
осциллограммы, 152

определение, 35
пользовательская настройка, 38
Пользовательская цветовая

палитра, 109
Пользовательские метки, 120
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последовательные запуски, 83
Последовательный

интерфейс, 197
Послесвечения экрана

экран, 103
предварительно определенные

математические
выражения, 150

предварительно определенные
спектральные
математические
выражения, 153

Предельный тест, 167
Предотвращение

электростатических
разрядов, 6

Прикладное программное
обеспечение, 190

Примеры, 192
Примеры применения, 192
Принадлежности, 1
Принудительная

синхронизация, 76
Пробник

калибровка, 38
компенсация, 38
компенсация временного

запаздывания, 38
P6616, 238
TPP0500, 230
TPP1000, 230

программное обеспечение
дополнительные, 190

Программное обеспечение
версия, 229
последний выпуск, 229

прокрутка увеличенных участков
осциллограммы, 114, 116

процесс выборки
определение, 38

Р
Рабочие характеристики, 3
расширенная полоса, 49
Расширенное эффективное число

битов, 43
Расширенный рабочий стол, 12,

196

Регистрация данных
входные каналы и цифровые

преобразователи, 38
выборка, 38

Регулятор
масштабирование, 117
панорамирование, 118

Режим автоматической
синхронизации, 76

режим прокрутки, 53
Режим регистрации Average, 42
Режим регистрации Envelope, 42
Режим регистрации Waveform

database (база данных
сигналов), 42

Режим сбора данных Hi Res
(высокое разрешение), 42

Режим сбора данных Peak Detect
(пиковое детектирование), 42

Режим Sample (выборка), 42
Режимы регистрации

определение, 42
Режимы сбора данных

изменение, 44

С
сегментированная память, 65
серийное тестирование с

маской, 163
Сетка увеличения, размер, 112
синхронизация

параллельная шина, 91
Сканирование события B, 87
MultiScope Trigger, средство

синхронизации с
мультископом, 71

Синхронизация
визуальный запуск, 95
выбор, 80
параллельная шина, 197
последовательная шина, 94
состояние, 82
типы, 80
Электронная почта по сигналу

запуска, 98
синхронизация по фронту

определение, 80
Синхронизация по шине CAN

определение, 81

Синхронизация с блокировкой, 80
Синхронизация с задержкой, 77,

83
Система синхронизации

Pinpoint, 76
Сканирование события B, 87
Случайные шумы, 42
снимок, 143, 144
событие запуска

определение, 76
сообщение электронной почты в

случае события
настройка, 99

Сохранение
данные гистограммы, 185
изображения с экрана, 176
маски, 184
метки времени, 186
настроек, 181
настройки прибора, 181
осциллограмм, 177
осциллограммы, 177
результатов измерений, 183

Сохранение цифровых
осциллограмм, 180

спектральное математическое
выражение
дополнительное, 154

Спектральный анализ, 153
Стандартный замок, для

переносных компьютеров, 11
статистики, 143
Стиль масштабной сетки

CrossHair, 107
Стиль масштабной сетки

Frame, 107, 108
Стиль масштабной сетки Full, 107
Стиль масштабной сетки Grid, 107
Стробирование, 142
Схема боковой панели, 20
Схема задней панели, 20
Схема интерфейса, 23
Схема панели управления, 25
Схема передней панели, 17
Схема экрана, 23

Т
тестирование с маской, 163
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Технические характеристики, 202
входные каналы и

разрешение по
вертикали, 202

источник питания, 7, 224
механические, 224
порты ввода/вывода, 223
последовательная

синхронизация, 220
при работе, 3
разрешение по горизонтали и

регистрация, 215
синхронизация, 218
Требования к окружающей

среде, 226
Тип входа

синхронизация, 77
точки

отображение точек записи
осциллограммы, 102

У
Увеличение полосы

пропускания, 49
Установка, 1

Ф
Формат отображения X-Y-Z, 104
функция расширения полосы, 49

Ц
цвета для эталонных форм

сигналов, 110
Цветовая палитра Monochrome

gray (монохромная
серая), 109

Цветовая палитра Normal, 109
Цветовая палитра Spectral Grading

цветовая палитра, 109
Цветовая палитра Temperature

grading (температурная
градация), 109

цветовые палитры, 109
Цифровые каналы

аналоговые
характеристики, 64

вход сигнала, 54
установка, 55

Цифровые осциллограммы
сохранение, 180

Ч
Чистка, 228
Чистка внешних

поверхностей, 228

Ш
Шина, 197

настройка, 60
настройка параллельной

шины, 59
настройка последовательной

шины, 57
установка шины, 56

Шины, 197
Ширина стробированной зоны

и полоса пропускания
разрешения, 155

Э
экранная надпись

синхронизация, 83
Экранные кадры

сохранение, 176
экранные курсоры, 146
экранные сообщения, 106
Экспорт См. Сохранение
электронная почта по сигналу

запуска, 98
электронная справка, 29
Электростатический разряд

предотвращение, 6
Эффективное число битов

расширенное, 43

A
ARM, индикатор состояния, 82
Autoset, 37

C
CAN, 197

D
D15-D0, кнопка, 63
Display Remote, 11

E
ENOB, 43

F
FastAcq/WfmDB palette, 109
FastFrame, режим быстрой записи

кадров, 65
Поиск кадров, 69

H
Help (Cправка), 29

I
I2C, 197
iView, 200

M
MagniVu, 63
MIPI CSI-2, 197
MIPI DSI-1, 197
Monochrome green (монохромная

зеленая) палитра цветов
экрана, 109

MultiScope Trigger, средство
синхронизации с
мультископом, 71

MultiView, лупа, 111
MyScope

изменение, 174
использование, 173
создание окна

управления, 169

O
OpenChoice

пример, 196

P
Pause (пауза), 118
Play (воспроизведение), 118

R
READY, индикатор состояния, 82

S
SPI, 197

T
TekLink, 71
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TRIG'D, индикатор состояния, 82

W
Wave Inspector, функция, 117

X
X-Y, формат отображения, 104

Y
Y-T, формат отображения, 104
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